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WARRANTY AND LIABILITY - LIMITATION: Seller warrants the products 
manufactured by it, or by an affiliated company and sold by it, and described on 
the reverse hereof, to be, for the period of warranty coverage specified below, free 
from defects of materials or workmanship under normal proper use and service. 
The period of warranty coverage is specified for the respective products in the 
respective Seller instruction manuals for those products but shall not be less than 
one (1) year from the date of shipment thereof by Seller. Seller's liability under this 
warranty is limited to such of the above products or parts thereof as are returned, 
transportation prepaid, to Seller's plant, not later than thirty (30) days after the 
expiration of the period of warranty coverage in respect thereof and are found by 
Seller's examination to have failed to function properly because of defective 
workmanship or materials and not because of improper installation or misuse and 
is limited to, at Seller's election, either (a) repairing and returning the product or 
part thereof, or (b) furnishing a replacement product or part thereof, transportation 
prepaid by Seller in either case. In the event Buyer discovers or learns that a 
product does not conform to warranty, Buyer shall immediately notify Seller in 
writing of such non-conformity, specifying in reasonable detail the nature of such 
non-conformity. If Seller is not provided with such written notification, Seller shall 
not be liable for any further damages which could have been avoided if Seller had 
been provided with immediate written notification.

THIS WARRANTY IS MADE AND ACCEPTED IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, WHETHER OF MERCHANTABILITY OR 
OF FITNESS FOR A PARTICULAR PURPOSE OR OTHERWISE, AS BUYER'S 
EXCLUSIVE REMEDY FOR ANY DEFECTS IN THE PRODUCTS TO BE SOLD 
HEREUNDER. All other obligations and liabilities of Seller, whether in contract or 
tort (including negligence) or otherwise, are expressly EXCLUDED. In no event 
shall Seller be liable for any costs, expenses or damages, whether direct or 
indirect, special, incidental, consequential, or other, on any claim of any defective 
product, in excess of the price paid by Buyer for the product plus return 
transportation charges prepaid.

No warranty is made by Seller of any Seller product which has been installed, 
used or operated contrary to Seller's written instruction manual or which has been 
subjected to misuse, negligence or accident or has been repaired or altered by 
anyone other than Seller or which has been used in a manner or for a purpose for 
which the Seller product was not designed nor against any defects due to plans or 
instructions supplied to Seller by or for Buyer.

This manual is intended for private use by INFICON® Inc. and its customers. 
Contact INFICON before reproducing its contents.

NOTE: These instructions do not provide for every contingency that may arise in 
connection with the installation, operation or maintenance of this equipment. 
Should you require further assistance, please contact INFICON.
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Chapter 1
Introduction

1.1  Introduction

The SQS-242 Deposition Control Software, see Figure 1-1, works with the 
INFICON SQM-242 card to provide a powerful, PC based thin film deposition 
controller that can:

 Measure up to eight quartz crystal sensors simultaneously.

 Control up to six deposition source supplies simultaneously (CoDeposition).

 Provide PreConditioning, multiple rate ramps, and feed/idle phases.

 Graph deposition rate, rate deviation, or power output.

 Store process, film and material parameters in Microsoft Access® database

 Provide flexible and reliable digital I/O using an inexpensive PLC (PLC not 
provided by INFICON).

Figure 1-1  SQS-242 Software
  1 - 1
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The six Soft Keys provide easy access to the common operating functions. A single 
tabbed dialog box provides all of the settings required for a thin film process. 
Material parameters, sensor/source setup, pre/post conditioning, and error 
conditions are all visible on a single dialog box. Process settings, numeric data, and 
graphical displays are displayed during all phases of deposition.

The SQS-242 software stores process parameters in a Microsoft Access 
compatible database. The SQS-242 software can be controlled from another 
computer using the RS-232 or Ethernet command protocol.

1.2  SQM-242 Deposition Control Card

The SQM-242 is a PCI expansion card for use in computers running the Microsoft® 
Windows operating system. See Figure 1-2. Each card measures up to four 
quartz sensors via BNC inputs, and supplies the control signal for two evaporation 
sources via a ¼” stereo phone plug. Up to six SQM-242 cards can be installed in a 
computer. A single SAM-242 piggyback card with four analog inputs and two 
control outputs can also be installed.

Figure 1-2  SQM-242 Card

Consult the separate SQM-242 card Operating Manual for detailed information on 
installing and using the SQM-242 and the SAM-242 cards.
1 - 2  
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1.3  Digital I/O

Digital I/O for the SQS-242 software can be provided through an inexpensive, 
external, programmable logic controller (PLC), see Figure 1-3. This allows the 
PLC, and the associated I/O wiring, to be placed in a convenient location in a wiring 
cabinet. A single, serial communications cable runs to the computer. The PLC 
provides electrical isolation, fail-safe operation, and extensive I/O processing 
capabilities through its ladder logic programming.

Figure 1-3  Programmable Logic Controller (PLC)
  1 - 3
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Chapter 2
Quick Start

2.1  Introduction
This chapter will provide a general overview on how to setup the SQS-242 
deposition control program.

1 Power On the Computer.

2 Start the SQS-242 software from: Start Menu >> Programs >> INFICON >> 
SQS-242 Codep.

3 User Login Dialog Box

The SQS-242 displays a progress bar during program startup, then a User 
Login dialog box. Select a User Name from the drop down box, enter the 
Password, then click OK. See section 3.5.5 on page 3-30 for more information 
on users, passwords, access levels, and registration.

NOTE: The SQS-242 software has one pre-assigned user by default. The user 
name is Super, with no Password.

4 Process Database

The SQS-242 normally starts with the last active process displayed. If that 
process is not found, a Database Open dialog is displayed. 

5 Main Display

As you operate the SQS-242, the six SoftKey labels along the left of the dialog 
box will change to display appropriate functions. 

Along the top of the display is a menu of less commonly used functions. This 
menu is available only when the SQS-242 is stopped (i.e., not running a 
deposition process).

6 Simulate Mode

Simulate mode allows you to familiarize yourself with SQS-242 operation and 
test process recipes. Simulate Mode will be used for the remainder of this 
chapter.

If the first SoftKey is labeled START SIMULATE then the Simulate mode is 
active. Otherwise, click the Edit menu selection along the top of the display, 
then click System. On the Card tab, click the Simulate button. Select the 
Close SoftKey to activate Simulate mode.
  2 - 1



IP
N

 0
7

4-
55

1-
P

1
A

 SQS-242 Operating Manual
2.2  Single-Layer Process Setup

We will build a simple single-layer process as an introduction.

2.2.1  Create a New Process

1 Click Edit >> Process.

2 The Process Edit dialog box will display the setup data for the active process. 
Click New.. See Figure 2-1.

Figure 2-1  Process Edit dialog box

3 Type a new process name using your keyboard, or the on-screen keyboard. 
Click Enter to save the new process name. See Figure 2-2.

Figure 2-2  Keyboard
2 - 2  
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2.2.2  Edit Layer Parameters

4 Click Layer to display the layer parameters. See Figure 2-3.

Figure 2-3  Layer tab

5 A Film is basically a material, plus the settings that will control its deposition. 
Select Film >> Gold Sample. 

6 We will be simulating a quartz sensor input that is controlling the deposition rate 
of Output 1. Select Output >> Output 1. 

7 Select Input >> Sensor(s).

8 Click SetPt, then adjust the rate setpoint to 10 Å/s. 

9 Adjust Final Thickness to 1.000 kÅ. 

NOTE: Time and Thickness Endpoints won’t be used for this example.

10 System Setup determines the physical inputs and outputs that are used and 
displayed on the dialog box. For now use the Default system setup. 

11 Manual Start causes this layer to wait for user input before beginning. An 
optional user prompt is possible. 

12 We won’t use any indexers for this example, so select None.
  2 - 3
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2.2.3  Edit Rate Ramps

A thin-film deposition process consists of one or more layers of material 
evaporated onto a substrate. Figure 2-4 illustrates a complete deposition cycle for 
a single layer. Refer to this diagram as we set the remaining parameters.It may be 
desirable to vary the deposition rate during a layer. For example, to deposit slowly 
at first, then more quickly once the initial material is deposited. 

Figure 2-4  Complete Deposition Cycle for a Single Layer

13 Click Rate Ramps. See Figure 2-5.

Figure 2-5  Rate Ramps tab

14 Click Insert Ramp. 

15 Set Start Thickness to 0.400 kÅ.

16 Set Ramp Time to 5 seconds.

17 Set New Rate to 15 Å/s.

NOTE: Settings on the Layer and Rate Ramp tabs must be set for each layer in 
a process. Settings on the remaining four tabs (Deposit, Condition, 
Source/Sensor, and Errors) correspond to the Film that was selected on 
the Layer tab. This allows a Film’s settings to be used in a number of 
layers, without the need to individually adjust each layer.
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2.2.4  Edit Deposition 

18 Select the Deposit tab. See Figure 2-6.

Figure 2-6  Deposit tab

19 Set gain (P Term) to 55.

20 Set time constant (I Term) to 0.7.

21 Set dead time (D Term) to 0. 

22 Be sure Shutter Delay Enabled is not selected. 

23 Set Rate Sampling to Continuous.

2.2.5  Edit Pre/Post Conditioning

24 Before deposition begins, the source material is often brought to a ready state 
by slowly raising the evaporation source power. Select the Condition tab and 
set each parameter to the values shown in Figure 2-7.

Figure 2-7  Condition tab
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2.2.6  Edit Source/Sensor

25 Select the Source/Sensor tab. See Figure 2-8

Figure 2-8  Source/Sensor tab

26 Select the proper material for this film, Gold. 

27 Set the maximum power and slew rate that should be used for the selected 
material.

28 Sensor Tooling adjusts for differences in the substrate deposition and that 
measured by each sensor. Select 100% for now.

2.2.7  Edit Errors

29 Select the Errors tab, see Figure 2-9, to control the actions taken when a 
sensor or deposition control error occurs. You can elect to ignore errors 
(unlikely), stop deposition for this layer, or continue deposition at a fixed power 
level. Select Stop Layer for this example.

Figure 2-9  Errors tab

30 Until a process is well established, it is best to enable only the Crystal Fail error 
checking. Uncheck the remaining error conditions.
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2.2.8  Save Edits

31 Select the Close Form SoftKey to save this one-layer process. If you are 
prompted Do you want to change…. answer Yes to make this the current 
process.

32 Your new single-layer process is now the active process in the main window. 
Notice the process, layer, and time information above the graph.

2.3  Single Layer Process Simulation

If you have followed this chapter, you are ready to simulate a deposition process. 
First, take a look at the information provided on the main dialog box. See Figure 
2-10.

Figure 2-10  Information on Main Dialog Box

Process
Name

Elapsed Time
Run Number

Layer
Number

Elapsed Time

Phase
Name

Time Elapsed/Remaining
Percent Complete

Film(s)

Operating
Soft Keys

Film Film
Measurements Settings
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2.3.1  Setup Displays

Click the View menu and make sure that these options are selected: 

 Film Settings

 Film Readings

 Automatic

Note that the settings “ribbon” along the right side of the dialog box displays the 
pre-conditioning parameters you entered in the previous section.

2.3.2  Start Process

Verify that the top SoftKey label displays START SIMULATE. If START PROCESS 
is displayed, follow the instructions at the end of section 2.1 to enable simulate 
mode. Press the START SIMULATE SoftKey to start the process.

The process will start with preconditioning (i.e., Ramp1, Soak1, Ramp2, Soak2) 
as shown in Figure 2-11. Once preconditioning is complete, the process will enter 
the Deposit phase. 

Figure 2-11  Preconditioning

You may want to select ABORT SIMULATE, then START SIMULATE several 
times to familiarize yourself with the on-screen displays during preconditioning. 
You may also want to use the settings ribbon to adjust parameters while the 
process is running.
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2.3.3  Preconditioning Phases

Because we selected Automatic in the View menu, the graph displays Output 
Power during preconditioning, then switches to Rate during the deposition phase.

As shown in Figure 2-12, the initial deposition rate was 10 Å/s until a thickness of 
.400 kÅ. Then the deposition rate was ramped up to 15 Å/s, and held until the 
desired final thickness of 1.000 kÅ was achieved. At this point, this single-layer 
process is finished.

Figure 2-12  Deposition Rate

2.3.4  Deposition Phase with one Rate Ramp

You should adjust the PID parameters on the setting ribbon, then Start/Stop the 
process several times to become familiar with their effect on control loop response. 

NOTE: In Simulate Mode, a deposition rate is not “measured” until the output 
power exceeds 50%. 
  2 - 9
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2.4  SoftKey Functions
As you have seen, the SoftKey functions remain constant during deposition. Spend 
a few minutes to become familiar with each of these SoftKey functions.

START PROCESS

Starts the first layer of a process when START is pushed. If AUTOMAN is shown 
on the third SoftKey (AUTO mode) the process starts PreConditioning. If 
MANAUTO is shown on the third SoftKey (MANUAL mode) the process 
immediately starts in the Deposition phase. 

ABORT PROCESS

Aborts the process. The process can only restart at the first layer.

START LAYER

Starts a stopped layer, or a layer that has been designated Manual Start in the 
process database. Starts the layer based on the state of the AUTO >> MAN 
SoftKey as described above.

STOP LAYER

Stops the current layer. Also changes the function of the first SoftKey to NEXT 
LAYER.

NEXT LAYER

Abandons the current layer and moves to the next layer in the process. If it is the 
last layer of a process, the same as pushing ABORT PROCESS.

AUTOMAN

When AUTOMAN is pushed, the source output is set to manual control. You may 
adjust the output using the settings ribbon. Because the PID loop is not running, 
you can manually set the output power to different levels and observe the 
associated deposition rate.

MANAUTO

Returns the output to PID loop control. If the process is running (ABORT 
PROCESS and STOP LAYER shown on the first two SoftKeys) deposition 
continues. If the process is stopped, sets the output to zero and awaits a start 
command.

ZERO

Resets the thickness reading to zero.

NEXT FILM

Sequences the setting ribbon through each Film in a codeposition layer.

NEXT SETTING

When the settings ribbon is shown, sequences the setting knob action through 
each of the displayed parameters.
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2.5  Multi-Layer CoDeposition Process

Our final example builds on the previous sections. If you have modified the setup 
of your process, return to section 2.2, Single-Layer Process Setup, on page 2-2 
and adjust the process to those values. When your single-layer process matches 
section 2.2, complete these steps:

1 Duplicate a Layer

Open the Edit Process dialog box. Click on Layer 1, click the Layer tab, then 
click Copy Layer. Now click Paste Layer. A duplicate Gold Sample film will be 
added as Layer 2. Click Paste Layer again to add a third Gold Sample layer.

2 Select a CoDep Film

Select Layer 3 in the layers list. Select Films >> Silver Sample. Select Output 
>> Output 2. The layers list will update to show the new Silver Sample film 
assigned to Layer 3. 

3 Add a CoDep Layer

Select Layer 3 in the layers list, then click Cut Layer. Now select Layer 1. Click 
Paste CoDep. The Silver Sample film will be added below Gold Sample as a 
codeposition layer. Your setup should match Figure 2-13.

Figure 2-13  Added CoDep Layer
  2 - 11
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We now have two layers in our process. Layer 1 has Gold being deposited from 
source Output 1 and Silver is being codeposited on Output 2. Layer 2 is Gold alone.

HINT: It’s easiest to copy a layer, then paste several temporary layers of that type 
as additional layers. Next, assign the films and outputs that you want to 
each of these additional layers. Now use Cut Layer on the temporary 
layers, and Paste CoDep to assign the film to the desired codeposition 
layers. Remember that each film in a codeposited layer must be assigned 
to a different source output! Review this example until you are comfortable 
with these concepts.

4 Edit Layer 1 Rate & Thickness

Click Silver Sample in the list of layers. Set Initial Rate to 15 Å/s, Final 
Thickness to 1.500 kÅ. Click the Rate Ramps tab and set Start Thickness to 
0.400 kÅ, Ramp Time to 15 seconds, and New Rate to 0 Å/s.

5 Edit Layer 2 Rate & Thickness

Click the Layer tab, then click Layer 2 Gold Sample. Set Final Thickness to 
0.5000 kÅ. 

6 Set Layers to Auto Start

At the end of deposition, you may choose to have the next layer wait for a Start 
Layer command, or to start automatically. Select each Layer in the layers list, 
then click Auto to set that layer to start automatically.

Verify that your process matches the one shown in Figure 2-14.
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Figure 2-14  Process Edit Dialog Box

7 Edit Silver Conditioning

Select the Condition tab and the Silver Sample layer. Set each parameter to 
the values shown in Figure 2-15.

Figure 2-15  Condition Tab for Silver Sample Layer
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8 Save Edits

Click Close Form or press the first SoftKey to save this two-layer codeposition 
process. Answer Yes if it displays the Do you want to change…. message box 
to make this the current process.

9 Start Process

Press the START SIMULATE SoftKey to start the first layer preconditioning 
phases. Note that two outputs are displayed for this codeposition layer.

Preconditioning of the two materials is entirely independent. If the 
preconditioning of one layer takes longer than the other, the start times are 
adjusted so that the end times coincide. 

When preconditioning ends, codeposition of the two materials begins. 

Your response should be similar to the graph shown in Figure 2-16 (your vertical 
scale may be slightly different). The slight ringing on the waveforms indicates some 
further tuning may be desired. However, this is an example of a reasonably well 
tuned loop. 

Figure 2-16  Start Process Response

At 0.400 kÅ thickness, the Silver Sample deposition rate ramps down from 15 Å/s 
to 0. Similarly, at 0.400 kÅ thickness the Gold Sample film ramps to a higher 
deposition rate of 15 Å/s. Because the initial rate for Gold was set lower than the 
initial rate for Silver, Gold reached its 0.400 kÅ thickness rate ramp trigger later in 
the deposition cycle.
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Try a P Term in the 25-30 range (less gain) for both Gold and Silver to decrease 
the loop susceptibility to noise. Increasing the I Term a little, say toward 1.0, will 
lessen overshoot during rate changes. The D term can be thought of as a “dead 
band” term. Most systems require little or no D term.

2.6  Conclusion

Spend some time with this process to become familiar with its setup and the effect 
of changes on deposition performance.

Because we selected Simulate Mode at the beginning of this Quick Start session, 
the SQM-242 card is “faking” an actual process. You can use the Simulate feature 
at any time to become familiar with SQS-242 operation and the effect of various 
settings on process performance. It is also a very useful feature for pre-testing your 
process setups. Return to the Edit menu, then select System and set the Mode to 
Normal to begin running your real process with the SQS-242 software.
  2 - 15
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Chapter 3
SQS-242 Software

3.1  Introduction
This chapter covers the minimum system connections and initial setup required to 
run the SQS-242 software. Consult the SQM-242 operating manual for more 
detailed instructions. See Figure 3-1.

Figure 3-1  SQM-242 Setup

1 Sensor Input Connections

Connect the BNC cables and oscillators from your vacuum chamber 
feedthrough to the desired SQM-242 Card Input(s). Refer to Chapter 2 of the 
SQM-242 manual for detailed instructions on system hookup to the SQM-242 
card(s).

2 Source Output Connections

Connect the dual phone plug from the SQM-242 output jack to your 
evaporation supply control input. Refer to Chapter 2 in the SQM-242 manual 
for detailed instructions on wiring the SQM-242 output phone plug.

3 Digital I/O Connections

Digital I/O is not required for initial operation of the SQS-242 software. Perform 
initial setup and checkout of the SQS-242 before connecting your digital I/O. 
See Chapter 4 for detailed information on wiring the SQS-242 for digital I/O.
  3 - 1
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WARNING

Care should be exercised to route cables as far as 
practical from other cables that carry high voltages or 
generate noise. This includes other line voltage cables, 
wires to heaters that are SCR-controlled, and cables to 
source power supplies that may conduct high transient 
currents during arc down conditions

A typical deposition cycle for a thin film is shown in Figure 3-2. The cycle can be 
broken into three distinct phases: pre-conditioning (ramp/soak), deposition, and 
post-conditioning (feed/idle)

Figure 3-2  Typical Deposition Cycle

During pre-conditioning, power is applied to prepare the source material for 
deposition. The first ramp/soak preconditioning phase is used to bring the material 
to a uniform molten state. The second ramp/soak phase is typically set to a power 
that is near the desired deposition rate. 

When pre-conditioning ends, PID rate control of deposition begins. Initially, the 
substrate material may remain shuttered until the desired deposition rate is 
achieved (shutter delay). Once the control loop achieves the desired rate, the 
shutter opens and deposition begins. Multiple deposition rates (rate ramps) can be 
programmed.

When the desired thickness is reached, the evaporation source is set to feed or idle 
power. At this point the process may be complete, or deposition of another film 
layer may begin. Up to six separate films can be codeposited within a single layer. 
There is no practical limit to the total number of processes, layers, or materials that 
can be stored in the process database.
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3.2  Installation and Registration

The SQM-242 card can be installed before or after the SQS-242 software. Consult 
the separate SQM-242 card User’s Guide for installation information. To install the 
program, insert the disk or CD-ROM. Click Start, then Run, then type <d>:Setup 
(where <d> is the drive you are using). Click OK to begin installation, and follow the 
on-screen prompts. When installation is complete, you may be prompted to restart 
the computer.

To start the SQS-242 program, click Start >> Programs >> INFICON >> SQS-242. 
If you see this Registration dialog box appear (see Figure 3-3.), you have a older 
version of the SQS-242 software. contact INFICON for the latest version which 
removes this registration requirement.

Figure 3-3  Registration Dialog Box

3.3  Operation

When the program is first started, it displays a progress bar during startup, then a 
User Login dialog box (see Figure 3-4).

NOTE: The SQS-242 software ships with one pre-assigned user. The user name 
is Super, with no Password.

Figure 3-4  User Name

Select a User Name from the drop down box, type in the Password, then click OK 
to start the program.
  3 - 3
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If your software is configured for keyboardless operation, an on-screen keyboard 
will appear as shown below. You can use your normal keyboard or mouse to “type” 
the password, then click Enter. See System Setup, SQM-242 Setup later in this 
chapter to enable or disable the on-screen keyboard (see Figure 3-5).

Figure 3-5  On-screen Keyboard

An Access Level is associated with each User Name. The Access Level controls 
which software functions are available to each user. For example, only users with 
an Access Level of Supervisor can add new users. See the Security section of this 
chapter for information on setting up users.

The remainder of this chapter covers the purpose and operation of each software 
function, arranged by menu selections. For a more “operational” approach, consult 
the previous Quick Start chapter.

Menus: The menus along the top of the main dialog box provide access to 
functions for building deposition processes, configuring the hardware for your 
vacuum system, and data display.

SoftKeys: The six switches to the left of the display are used for the normal 
operation of the instrument, and to navigate the setup programs (see below for the 
individual switch functions). Just move the cursor over the key label on dialog box 
and single click the mouse. You can also use the keyboard F1 to F6 function keys 
to simulate the front panel function switches. The SoftKeys change during 
operation to address different user input requirements.

3.4  Menu

NOTE: The current process must be stopped for the File menu to be available.

3.4.1  File: Process

Used to select a process from a list of all processes in the current database. If the 
process selected is different than the current process, you are prompted to confirm 
the change.
3 - 4  
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3.4.2  File: Open and Save Database

Open Database: Selects a process database to be used for deposition. 
Remember, a single process database may contain an unlimited number of 
processes, films, and materials. See Figure 3-6.

Figure 3-6  Open Database File dialog

Save Database As: Saves the current process database to disk under a different 
name. This is useful for saving the process database to floppy disk (for backup!), 
or for making trial changes without affecting your working database. Process 
databases are saved in Microsoft Access® format.

Once again, a pop-up keyboard may appear. If you want to browse, just select 
Cancel from the pop-up keyboard. 

3.4.3  File: Data Logging

Logs data from a deposition process to a disk .LOG file. There are four options for 
file naming and logging. See Figure 3-7.

Log File: Select None to disable data logging. If Overwrite is selected, the last run 
of the process is saved as FileName.LOG (where FileName is the name shown in 
the FileName text box). Subsequent runs overwrite the log file. If Append is 
selected, each run is appended to FileName.LOG. If Run# is selected, each run of 
the process is saved as a separate file under the format FileName_Run#.LOG.

Changing Run# on this dialog box will also change the Run# displayed at the top 
of the main program dialog box.
  3 - 5
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Figure 3-7  Data Logging

Normally, the log file is saved to the folder where the program is installed. If desired, 
you can click Select and navigate to a different folder. Log files can be viewed in 
Notepad by clicking the View button. 

NOTE: To avoid delays in data acquisition DO NOT log data to a floppy disk file. 
Instead, save to the hard disk, and transfer the files to a floppy disk later.

Events to Log: A number of “events” can trigger a data entry in the log file. End 
Deposit Phase records process data (rate, thickness, time, etc.) at the end of each 
layer’s deposit phase. Similarly, End Each Phase logs data at the end of each 
phase (conditioning, depositing, etc.). I/O Events logs data each time an external 
digital input or output changes. 

Timed logging records data at the selected time intervals throughout the process. 
Click the Sensors box to include individual sensor data in addition to the normal film 
based data. Click Analog Inputs to also log that data.

Finally, click Readings to log every reading from the SQM-242 card(s). The file will 
be saved in the application directory with a name in yymmdd.log format. That is, 
readings logged on January 15, 2011 will be saved as 110115.log.

NOTE: This file can grow quite large and cause Windows to slow significantly. 
Typically, the Timed option is a better choice unless you must record every 
reading. When Readings is selected, a reminder dialog box appears each 
time the SQS-242 program is started.
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Format: There are two formats for writing data. If Spreadsheet is selected, each 
entry is a comma-delimited line of data. If Text is selected, the data is formatted for 
easy reading. The first few lines of the LOG file is a heading that illustrates the file 
format and content.

NOTE: To use a different delimiter than a comma, change the SQS242.INI file so 
that under the [DataLog] section, the LogDelimit= entry shows the 
character you want to use. To use a <TAB> character, type the word Tab. 
See section 3.8 on page 3-37.

3.4.4  File: Print

Print Process: Prints the parameters for the current process to the system printer. 
Select Print to File in the Printer Setup Menu to print the data to a file.

Print Setup: Selects and modifies the current system printer.

3.4.5  File: User Login

Displays the User Login dialog box so that a different user may log in. The existing 
user is logged off automatically. The user Access Level changes immediately to 
that of the new user. See the Edit, Security section for more information on Users, 
Passwords, and Access levels.

3.4.6  File: Exit

Exits the SQS-242 deposition control program and saves the current data.
  3 - 7
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3.5  Edit Menu
3.5.1  Edit: Process

A process is a sequence of thin film layers. Multiple films deposited in the same 
layer are known as CoDeposition. The Process Edit dialog box, see Figure 3-8, 
provides the functions needed to develop a thin film deposition process from the 
database of existing films and materials. 

Figure 3-8  Process Edit dialog

Controls along the top of the Process Edit dialog box apply to the entire process:

Process: A dropdown box that selects the process to be edited. Defaults to the 
current process. Below the process dropdown, a listing of each layer assigned to 
the Process. CoDeposition layers are listed with the same layer number, but a 
different output. 

Rename: Edits the name of the selected process.

New: Creates a new process. Since every process must have at least one film, the 
first film of the currently selected process is used.

Delete: Deletes the selected process from the database. There is no undelete!

Copy: Creates a duplicate of the currently selected process.
3 - 8  
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Layers List: To select a process layer, click on it in the Layers list. 

Cut/Copy/Paste the selected layer as described below:

Cut Layer: Removes the selected layer from the process and places the layer on 
the clipboard.

Copy Layer: Places the layer selected in the Layers list box on the clipboard, 
without removing it from the process.

Paste Layer: Inserts the clipboard layer above the currently selected layer in the 
Layers list box. Existing layers are shifted down.

Paste CoDep: Pastes the clipboard layer as a CoDeposition layer at the currently 
selected layer number. Attempting to paste a layer that uses an output already 
assigned to the selected layer generates an error message.

HINT: To add layers to a process, it is easiest to select an existing layer in the 
layers list, then click Copy. Click Paste repeatedly to insert several 
temporary layers. Next, assign the proper film and layers parameters to 
each of these temporary layers. 

To change one of the temporary layers to a CoDep layer, highlight the temporary 
layer and click Cut Layer. Next click the layer desired for CoDep and click Paste 
CoDep to assign the selected layer.

Controls in the tabbed control apply to the layer selected above, in the Layers list. 
The Layer and Rate Ramp tabs assign layer-specific parameters to the selected 
layer. Note that captions on the Layer tab may change, depending on the input and 
output selections. The remaining tabs provide access to the film assigned to the 
selected layer.

NOTE: Edits to the Deposition, Condition, Source/Sensor, and Error tabs will 
affect all processes and layers that use the selected film!
  3 - 9
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3.5.1.1  Layer Tab

Figure 3-9  Layer Tab

Film DropDown Box: Assigns a film to the selected layer. A film is basically a 
Material, plus the other settings shown on the Deposit, Condition, Source/Sensor, 
and Error tabs.

Output DropDown Box: Selects the output that is used for deposition of the 
selected layer’s film. A particular film often uses the same output (i.e., a thermal 
boat or E-Beam pocket).

NOTE: Due to the way outputs are stored in the process database, the physical 
output number (not its name) is listed in the layers listing. Outputs 1 and 2 
refer to the first SQM-242 card outputs. Outputs 3 and 4 refer to the second 
SQM-242 card outputs (if installed). Outputs 13 and 14 are the SAM-242 
card outputs (if installed). 

Input DropDown Box: Selects the input used to measure and control deposition 
of the selected layer. The combination of an output and its input defines the 
deposition “control loop” for the selected layer. The Input selection can significantly 
alter operation of the deposition phase, as described in the following discussion on 
the SetPt parameter.
3 - 10  
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SetPt: The function of the setpoint parameter depends on the Input dropdown. If 
Sensor(s) are used as the input, the setpoint is Rate (in Å/s). This sets the initial 
Rate setpoint for the selected layer. Rate is controlled by the PID parameters for 
the film assigned to the layer. If no rate ramps are defined for the layer, this is the 
rate setpoint for the entire layer. 

If the Input selected is Timed Power, the setpoint is shown as % Power. This sets 
a fixed % output Power during deposition. In Timed Power the Time Endpoint 
establishes the length of time for the deposition cycle. The layer will end when 
either the time endpoint is reached, or when the Final Thickness is reached, 
whichever occurs first. 

If one of the SAM-242 analog inputs are selected, the setpoint is in volts (or the 
analog input’s corresponding user-defined units). The layer will end when either 
Time Endpoint or Final Thickness is reached, whichever occurs first. See the 
Analog Inputs section later in this chapter for a discussion of programming for 
analog inputs.

Final Thickness: Sets the endpoint thickness for the layer. When final thickness is 
reached, deposition is stopped for that layer and the feed/hold phase is entered.

Time EndPoint: Sets an arbitrary time, after deposition begins, when the time 
setpoint relay is activated. During % Power and Analog Input deposition, it also sets 
the length of the deposition cycle.

Thickness EndPoint: Sets an arbitrary thickness that activates the thickness limit 
relay.

Auto/Manual/Continuous Start: Auto Start begins the next layer automatically 
upon completion of the previous layer. Continuous ignores Conditioning phases 
and controls continuously at rate setpoint (see Analog Inputs). If Manual Start is 
selected, the previous layer ends at its idle power and waits for the user to push 
the Start Layer switch. An optional User prompt can be entered for Manual Start 
layers. (This feature can be disabled by editing ShowPrompts in the SQS242.INI 
file). 

NOTE: The following parameters are common to all of the films in a layer. In the 
previous dialog box shot for this section, both layer 1.1 and 1.2 would 
share common values for the following parameters. Layer 2.1 could have 
different values.

System Setup: System setup assigns outputs to their controlling sensors (called 
sensor mapping). It also determines which physical sensor and output connections 
are displayed on the main dialog box. See section 3.5.4 Edit: System for detailed 
system setup information.

Source Index: Assigns each film to a specific source indexer pocket (one of 16 
values). Each of the six possible outputs is associated with a unique source 
indexer. These values are sent to the digital I/O (PLC) at the beginning of each 
layer. 
  3 - 11
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Substrate Index: If using a substrate indexer, assigns the substrate to one of 16 
possible values. These values are set at the beginning of each layer.

User1/User2 Index: These additional values are output to the PLC for use as 
needed. Common applications are to select external equipment configurations. 
(The Index names, the range of values (0 to 15, or 1 to 16), and the first entry can 
be customized by editing entries in the SQS242.INI file - See section 3.8).

3.5.1.2  Rate Ramps Tab

Rate ramps cause changes to the deposition rate over time under PID control. 
Each rate ramp has a starting thickness, an elapsed time to ramp to the new rate, 
and a new rate setpoint. Each process layer can have an unlimited number of rate 
ramps. See Figure 3-10.

Figure 3-10  Rate Ramps tab

Insert Ramp: Inserts a new rate ramp for the selected layer, at the selected 
position in the rate ramps list. Existing rate ramps are shifted down.

Delete Ramp: Deletes the selected rate ramp.

Move Up: Shifts the selected rate ramp up one position.

Move Down: Shifts the selected rate ramp down one position.

Start Thickness: The thickness that triggers a timed ramp to a new rate. (Start 
thickness should be greater for each subsequent ramp, and less than the final layer 
thickness, otherwise the rate ramp is ignored.)
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Ramp Time: The time (in seconds) to ramp to the new rate. If the rate ramp is too 
fast, a PID control error may be generated.

New Rate: The new deposition rate setpoint for the selected layer.

3.5.1.3  Deposit Tab

The Deposit tab contains parameters that directly affect the deposition phase of 
the process cycle. See Figure 3-11.

Figure 3-11  Deposit tab

P Term: Sets the gain of the control loop. High gains yield more responsive, but 
potentially unstable loops. Try a value of 25, then gradually increase/decrease the 
value to respond to step changes in rate setpoint. 

I Term: The integral term controls the time constant of the loop response. A small 
I term, say 1 to 3 seconds, will smooth the response of most loops.

D Term: The differential term causes the loop to respond quickly to changes. Use 
0 or a very small value (.1 x I Term) to avoid oscillations.

Shutter Delay: It is often desirable to assure stable process control before the 
substrate shutter opens. Enabling shutter delay requires that the system reach the 
programmed shutter delay Accuracy, and maintain that accuracy before deposition 
begins. If the accuracy is not reached within Wait seconds, the process halts. If 
  3 - 13
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accuracy is achieved, and maintained for Hold seconds, then the substrate shutter 
opens and deposition begins. The Thickness reading is zeroed at the end of the 
shutter delay period. 

Rate Sampling: Rate sampling can extend the life of crystals. With rate sampling, 
the deposition rate is sampled for a period of time, then the sensor shutter is 
closed. Power is then held at the same level as the final power setting during the 
sample period. 

Continuous selects no sampling; the sensor shutter remains open during 
deposition. Accuracy Based sampling opens the shutter until the desired accuracy 
is reached, leaves the shutter open for Sample time, then closes the shutter and 
holds power constant for Hold time. Time Based sampling opens the shutter for a 
fixed period of time then closes it for a fixed time.

3.5.1.4  Condition Tab

Before the deposition begins, it is often necessary to PreCondition the source 
material.   This places the system at the proper power level to achieve rapid PID 
control when deposition begins. See Figure 3-12.

Figure 3-12  Condition tab
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Ramp 1: Ramp power sets the power level that is desired at the end of the ramp 
phase, in % of full scale. Ramp time sets the time to ramp with a linear rate from 
the initial power to the Ramp power. Soak time sets the time the output remains at 
the ramp power level.

Ramp 2: Ramp 2 functions are the same as Ramp 1. Typically, Ramp 2 power is 
set near the power level required to match the desired initial deposition rate. 
Selecting the Ramp2 Power Auto checkbox stores the power over the last few 
seconds of the deposit phase for this film. That value is used as the Ramp2 power 
for the next run of the selected film.

Feed: The feed phase begins immediately after deposition is complete. It holds 
output power at the level and time required to wire feed new material. 

Idle: The Idle phase follows the Feed phase.

3.5.1.5  Source/Sensor Tab

The Source/Sensor tab controls the physical setup of the deposition system. See 
Figure 3-13.

Figure 3-13  Source/Sensor tab

Material: Selects the physical deposition material for the film selected on the 
Layers tab. Selecting a material sets the Density and Z Factor, as defined in the 
Edit Materials dialog box.
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Max Power: The maximum output power allowed for the selected output. The full 
scale output voltage is a function of the deposition power supply input 
specifications, and is set in the Edit System menu, Outputs tab. Max Power 
controls the maximum % of the full scale power that can be used by this film in all 
phases (PreConditioning, Deposition, and Feed/Idle).

Slew Rate: The maximum power change allowed on an output, per second. If rate 
ramps or PID power requirements exceed this value, an error will occur.

Sensor Tooling: Adjusts for sensor measured deposition rates that differ from the 
substrate deposition rate. For example, if the sensor sees only 50% of the 
substrate rate, set the value to 200%. Setting Tooling to 0% causes a sensor to be 
ignored for this film.

The System Setup selection on the Layer tab establishes which sensor(s) are 
visible. Only those sensors “mapped” to the layer’s output are visible.

3.5.1.6  Errors Tab

Several source or sensor error conditions are possible during deposition. This tab 
establishes the program's response to errors. See Figure 3-14.

NOTE: It is best to leave all error settings, except Crystal Fail, disabled until you 
are confident of the stability and repeatability of your process.

Figure 3-14  Errors tab
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Control Error: If the control loop cannot maintain the desired deposition rate (due 
to loss of source material, excessively high rate ramps, or equipment malfunction) 
a control error occurs. Control error % is the accuracy that must be exceeded for 
the specified time (in seconds) to trigger a control error. Use shutter delay accuracy 
to assure adequate process control before entering the deposition phase.

Crystal Fail: Establishes the number of bad readings (i.e., 0 Hz) from a sensor that 
generates a Crystal Fail condition. If a crystal fails, the PID loop will send the 
source supply to max power. Therefore, it is unlikely you will ever want to disable 
this error.

Crystal Quality: Each time the rate deviation for this film exceeds the % value, a 
counter is incremented. Each time the rate deviation is within the % value, the 
counter is decremented (to zero minimum). If the counter exceeds the Counts 
value during the entire layer deposition, an error occurs. 

Crystal Stability: When material is being deposited, a crystal's frequency normally 
drops. At the end of crystal life, sensor frequency may briefly "mode hop" to higher 
frequencies. Single Hz is the largest single positive frequency shift allowed. Total 
Hz is the sum of positive shifts allowed during a film's deposition.

On Error: When an error condition occurs, three actions are possible. Ignore the 
error and let the PID loop attempt to maintain rate control. Stop the layer and allow 
the user to fix or manually control deposition. The last choice, Timed Power, uses 
the last good Rate/Power settings to "estimate" rate and thickness.

In Timed Power, the output is set to the power level that last yielded a rate reading 
within the Control Error % deviation setting (10% deviation if Control Error is 
disabled). The program then calculates the estimated thickness based on that rate 
and the deposition elapsed time. When the calculated thickness reaches thickness 
setpoint, deposition stops.

3.5.1.7  Analog Inputs

Normally the SQS-242 software uses SQM-242 card quartz sensor inputs to 
measure or control rate and thickness. The SAM-242 Analog Input Card extends 
this capability to allow measurement and control on DC voltage-based process 
variables such as temperature transmitters, pressure/flow controllers.

Analog input based control is treated, for the most part, identically to quartz sensor 
based control. Considerations for using an analog input are discussed below.

Layers Tab: In the Inputs dropdown, select one of the Analog inputs. In the Outputs 
dropdown, select the output that is to be controlled. Enter the desired setpoint. 
Normally this setpoint is in Volts, but can be converted to other units (e.g., degrees 
or PSI) in the Edit, System, Analog dialog box. 

Use Time Endpoint to stop the analog layer after a set time. Otherwise, a Sensor 
input, programmed as a Codep layer, can control the layer endpoint. Final 
Thickness and Thickness Endpoint settings have no effect for an analog input.
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If Continuous Start is selected the analog input controls to its programmed Layer 
Setpoint through all of the Ramp/Soak/Feed phases. This allows temperature or 
pressure control (for example) to be maintained through all phases of the layer. If 
Stop Layer is selected, control is still maintained at setpoint. Pressing Abort 
Process will set the output to zero.

Rate Ramps Tab: Setpoint ramps can also be programmed for an analog signal.

Deposition Tab: The PID and Shutter Delay controls operate the same as a 
Sensor input. Rate sampling is not possible for analog inputs.

Condition Tab: Conditioning is identical to that of a Sensor input. 

Source/Sensor Tab: Only Max Power and Slew Rate are functional.

Errors: Only Control Error applies.

The Analog Input’s measured value (converted to the defined units) and deviation 
from setpoint are shown below the graph. The analog input values are NOT shown 
on the normal Rate graph (the values could lead to poor rate resolution on the 
graph). Instead the analog input voltages are shown on the View, Analog graph. 
Volts are displayed on this graph, rather than the scaled units (again, to maintain 
adequate graph resolution).

3.5.2  Edit: Films

The Edit Films dialog, see Figure 3-15, allows you to rename, delete, and copy 
films. The functions in the tabbed control are identical to those for this film on the 
Edit Processes dialog. 

NOTE: Edits to a Film will affect all processes and layers that use that film!

Figure 3-15  Film Edit dialog
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Film: A dropdown box that selects the film parameters displayed in the edit film 
dialog box.

Rename: Edits the name of the selected film.

New: Creates a new film.

Delete: Deletes the currently selected film from the database. A film cannot be 
deleted if it is used in ANY process! To delete a film, you must first delete the film 
from each process where it is used.

Copy: Creates a duplicate of the currently selected film.

The function of each Edit Films tab, and its associated controls, are identical to 
those detailed in the Edit Processes section. Please consult section 3.5.1 on page 
3-8 for that information.

3.5.3  Edit: Materials

The Edit Material dialog, see Figure 3-16, provides the functions needed to build a 
materials database. In addition to the functions listed below, the main dialog box 
SoftKeys provide capabilities to add/edit/delete materials.

Figure 3-16  Material dialog

Rename: Edits the name of the selected material.

New: Creates a new material.

Delete: Deletes the currently selected material from the database. A material 
cannot be deleted if it is used in ANY process! To delete a material, you must first 
delete each film where it is used.

Material: Selects a material to edit.

Density: Sets the density for this material. Material density has a significant impact 
on deposition calculations.

Z-Factor: Sets the Z-Ratio, a measure of a material’s effect on quartz crystal 
frequency change. Z-Ratio has no effect on measurements when using a new 
crystal. If the Z-Ratio for your material is not known, using crystals with >80% life 
will eliminate the effect of the Z-Ratio term.
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3.5.4  Edit: System

The System Setup dialog, Figure 3-17, configures the SQS-242 software to the 
physical setup of your deposition system. Several settings that control the overall 
operation of the program are also accessed in System Setup.

The combination of sensor input and control output assignments, known as a 
System Setup, are stored in the SQS-242 database. Most systems will have a 
single setup that applies to all processes. However, complex systems may use 
several different system setups within a single process.

NOTE: Settings on the Outputs, Sensors, Analog, and Cards tabs are unique for 
each System Setup. Settings on the Indexers, I/O, and Comm tabs apply 
to all System Setups. Output colors are also common to all setups.

Figure 3-17  System Setup dialog

Controls along the top of the System Setup dialog box apply to the selected system 
setup:

System Setup: A dropdown box that selects the setup to be edited. Defaults to the 
current setup.

Rename: Edits the name of the selected setup.

New: Creates a new system setup, based on the existing default setup.

Delete: Deletes the currently selected setup from the database. If the setup is used 
in a process, an error message is displayed.

Copy: Creates a duplicate of the currently selected system setup.
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3.5.4.1  Outputs Tab

Figure 3-18  Outputs tab

Name: Assigns a name to each displayed output. For clear display, keep the name 
to less than 8 characters.

Physical Output: Up to six SQM-242 cards (physical outputs 1 to 12) and a single 
SAM-242 card (physical outputs 13 and 14) may be installed in a computer. 
However, the SQS-242 software can display and control a maximum of 6 outputs 
simultaneously. Use this dropdown to assign a “physical” output to a “display” 
output.

FS Out: The input voltage required by the deposition source power supply to 
produce 100% output power. Positive or negative full scale values are possible.

Color: Selects the color used to graph and display output data.

Test Output: Useful for testing output wiring and Full Scale voltage settings. Select 
an output, then click Full Scale to set the SQM-242 card output to its Full Scale 
voltage. Click Zero to return the selected output to 0 volts.
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3.5.4.2  Sensors Tab

Figure 3-19  Sensors tab

Name: A meaningful name assigned to each sensor. For clear display, keep the 
name to less than 8 characters.

Physical Sensor: Up to six SQM-242 cards (physical sensors 1 to 24) may be 
installed in a computer. However, the SQS-242 software can display a maximum of 
8 sensors simultaneously. Use this dropdown to assign a “physical” sensor to a 
“display” sensor. 

Dual: Indicates that a pair of sensors is set up as primary/secondary duals. When 
a primary sensor fails, the SQS-242 switches to the secondary sensor.

Monitor Output: Select the output that each sensor is positioned to measure. The 
rate and thickness displayed by the sensor will be calculated based on the material 
assigned to the selected output. 

Control Checkboxes: Click Rate to assign the sensor to the PID rate control loop 
for the assigned output during deposition. Click Thk to use the sensor for Thickness 
endpoint detection. Typically you will check both boxes so that the sensor controls 
to rate setpoint and detects the thickness endpoint. If multiple sensors are 
assigned to control the same output, the sensor readings are averaged when 
calculating rate and thickness.

Uncheck both boxes to have a sensor monitor an output, without controlling 
deposition rate or stopping when final thickness is reached.
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3.5.4.3  Analog Tab

Figure 3-20  Analog tab

The SAM-242 analog input card measures DC voltages in the +/-10 volt range. 
These voltages may represent temperature, flow, or any other process variable. 
The analog tab allows you to modify the display to show values in the desired units, 
using a linear (y = mx + b) transformation.

For example, assume you have a temperature transmitter that sends 0V at 0C and 
1V at 100C. To display temperature in F, set the Gain to 180, Offset to 32, and 
Units to DegF. The SQM-242 will display setpoints and measurements associated 
with the analog input in degrees F.

To leave the analog input display in Volts, set Gain = 1 and Offset = 0.

Name: A meaningful name assigned to each analog input. For clear display, keep 
the name to less than 8 characters.

Gain: The gain term for transforming voltage to measured units. This is the m term 
in y = mx + b.

Offset: The offset term for transforming voltage to measured units. This is the b 
term in y = mx + b.

Units: The units that you wish to display for the analog input.
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3.5.4.4  Indexers Tab

Figure 3-21  Indexers tab

Source Indexers: A unique source indexer (pocket rotator) is available for each 
output used. The source indexer moves at the beginning of each layer.

Layer Indexers: Three “layer indexers” are also available. Layer indexers also 
move at the beginning of each layer. Layer indexer values are useful for control of 
substrate indexers or other external process equipment.

NOTE: The Layer Indexer names, the range of values, and the first entry can be 
customized by editing entries in the SQS242.INI file (see section 3.8).

Complete Signal: Check this box if your indexer sends a signal indicating that the 
move is complete.

Timeout: If Complete Signal is checked, the process will halt if a move complete 
signal is not received within this timeout period. If Complete Signal is not checked, 
the process waits for this fixed time period before starting a layer.

Move: Useful for testing indexer functions manually. Select an indexer, then an 
index (pocket). Click Move to move to the selected index. Layer indexers are 
typically named Substrate, User 1, and User 2. Layer indexer names can be edited 
in the SQS242.INI file (see section 3.8). 

3.5.4.5  I/O Tab

A PLC must be used to provide digital I/O capabilities. The I/O tab assigns 
deposition events (i.e., open shutter, start deposit, final thickness, etc.) to the 
physical relays and inputs on the PLC.
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NOTE: Omron CPM series PLCs number relays from 10.00 to 10.07, then 11.00 
to 11.07. These correspond to Relays 1 to 16 on the I/O tab. Similarly, 
inputs 0.00 to 0.11 on the Omron PLC correspond to inputs 1 to 12 on this 
dialog box. See Figure 3-22.

Figure 3-22  I/O tab

Relay Events: The relay events dropdown box lists the deposition events that can 
cause a relay output to be activated. To assign a deposition event to a relay, click 
the Relay #, then select the desired event from the dropdown box. As you click 
each Relay#, the dropdown will change to show its currently assigned event. A 
description of each relay (output) event follows:

Source Shutter 1 to 6

These relays control the Shutter that covers your deposition source. At the 
beginning of the deposit phase the relay will close its contacts. When the 
deposit phase finishes the shutter relay contacts open.

Sensor Relays 1 to 8

These relays control sensor shutters. Their function depends on whether you 
have single or dual sensors.

If Dual Sensor is not selected (i.e., a single sensor), the relay contacts close when 
Shutter Delay phase is entered on a layer with the sensor enabled. As an example, 
let’s say you have sensors 1 and 3 enabled for Film 1 and sensors 2 and 4 enabled 
for Film 2. When you start Film 1 Shutter Delay phase, the contacts for Sensor 
Relays 1 and 3 will close. When you start Film 2, these contacts open and the 
contacts for Sensor Relays 2 and 4 will close when Shutter Delay is entered.
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If the software is configured for dual sensors, the relay operation is considerably 
different. Dual sensors use pairs of sensors (i.e., Sensor 1 and 2, or Sensor 3 and 
4). With Sensors 1 or 3 selected, the associated relay contacts are open. If a 
Crystal Fail is detected, the relay contacts for the failed sensor will close to select 
the second sensor in the Dual Sensor assembly for the duration of the film. 

Xtal All Good and Xtal All Fail Relays

These two relays provide an indication of the general health of your sensors. If 
the Xtal All Good Relay is closed, then all enabled sensors are returning a valid 
reading. If the Xtal All Fail Relay is closed, none of the enabled sensors are 
returning a valid reading.

Process Stopped and Running Relays

These relays indicate the overall status of the process. The Process Running 
relay closes as soon as Start Process is selected (by front panel or digital input), 
and opens when Abort Process is selected. Even if a layer is stopped within a 
process, the Process Running relay remains closed until the last film of a 
process has finished. The Process Stopped relay contacts behave in the 
inverse manner.

Layer Stopped and Running Relays

The Layer Running relay closes as soon as Start Layer is selected (by front 
panel or digital input), and opens when Stop Process is selected. The Layer 
Stopped relay contacts behave in the inverse manner.

Deposit Phase Relay

This relay indicates that you are in the deposit phase of a film. It is like having 
the two Source Shutter Relays connected in parallel. If you have shutter delay 
enabled, this relay will wait until the end of the shutter delay before going active.

Pre-Cond Phase Relay

This relay closes for the preconditioning phases (Ramp1, Soak1, Ramp2, 
Soak2) of a film.

Soak Hold Phase Relay

This relay closes for the Soak and Hold phases after deposition.

Process Active Relay

This relay action is similar to the Process Running relay, except it will open if 
the process is temporarily halted for any reason, e.g. a Manual Start layer.

Manual Mode Relay

Closes when the program is placed in Manual mode.
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Max Power Relay

Closes when any control voltage output is at the programmed maximum power 
level.

Thickness Setpoint Relay

This relay will become active when the Thickness Setpoint is reached. This is 
a programmable process parameter.

Time Setpoint Relay

This relay will become active when the Time Setpoint has been reached. This 
is measured from the beginning of the deposit phase, and is a programmable 
parameter.

Test: The Test section provides a simple means of testing I/O wiring. To close a 
relay, select the desired relay button, then click Set. Click Clear to open the relay 
contacts.

Input Events: The input events dropdown box lists the deposition events that can 
be caused by an external digital input. To assign a deposition event to an input, 
click the Input #, then select the desired event from the dropdown box. As you click 
each Input #, the dropdown will change to show its currently assigned event. A brief 
description of each input event follows:

Start Process Input

Triggering this input is the same as pushing the Start Process button.

Abort Process Input

Triggering this input will abort the process.

Start Layer Input

Triggering this input will start or restart the current layer.

Stop Layer Input

Triggering this input will stop the current layer.

Start Next Layer Input

Triggering this input will skip the current layer and start the next layer.

Zero Thickness Input

This will zero the thickness. It is identical to pressing the Zero button.

Force Final Thickness Input

Triggering this input has the same effect as reaching Final Thickness setpoint.

Comm Port: Selects the serial port used to communicate with the PLC. The Comm 
Port dropdown lists available ports. However, some ports may be used by other 
devices (modem, mouse, etc.). Select Disabled to prevent I/O from using the PLC.
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The communications parameters (baud, parity, bits, stop) are shown below the 
Comm Port dropdown. The baud rate can be changed in the SQS242.INI file (see 
section 3.8).

Address: Several PLCs can be controlled from a single computer Comm Port by 
connecting their expansion ports. The slave address of each such PLC is usually 
set by a rotary or dip switch, and must be unique. Single PLC systems usually use 
Address 0. Consult your PLC User Manual. 

If the PLC is found at the selected Comm Port and Address, the COMM LED on 
the PLC will flash continuously. The PLC model is displayed below the address.

3.5.4.6  Card Tab

Figure 3-23  Card tab

Mode: In Normal mode, the SQS-242 gets readings from the SQM-242 card(s). In 
Simulate mode, the SQS-242 generates simulated readings even if a card is not 
installed. This is useful for testing new processes and learning the software. 

The firmware revisions of the installed SQM-242 cards are listed below the mode 
buttons. A value of 0 indicates the card is not installed. Analog Rev refers to the 
revision of an SAM-242,card if installed. DLL Return is the status of the SQM-242 
card’s Windows drivers. DLL return values of 9XX indicate a card installation error.

Front Panel Enabled: When used with the SRC series computer, enables/disables 
the SQS-242 software to read the SoftKeys. 

Period: Sets the measurement period between 0.2 seconds (5 readings per 
second) and 2 seconds. A longer period gives higher reading accuracy, especially 
at low rates.
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Max/Init/Min Frequency: The frequency values for the quartz crystal sensors used 
as inputs to the SQM-242. Typical values are Max=6.1, Init=6.0, Min=5.0. Sensor 
readings outside the min/max values cause a Sensor Fail error.

Filter: Sets the number of readings used in the reading filter. A low setting gives 
rapid response to process changes, high settings give smoother graphs.

Last Output: Limits the maximum number of outputs shown on the main dialog 
box.

Continuous: Check this box to have the graph continuously display data for each 
phase of the deposition cycle. Uncheck this box to clear the graph at the end of the 
preconditioning, deposition, and post conditioning phases.

Graph X Axis: Sets the width of the X axis during deposition, normally 100 
seconds. Whatever width is selected, the graph automatically scrolls the X axis as 
required. Due to screen resolution, setting a width of more than 10 minutes (600 
seconds) may cause some data points to not be plotted.

Graph Y Axis: Sets the Y axis Rate graph maximum value during deposition. 
Setting the value to 0 causes the Y axis to automatically scale to the highest rate 
displayed.

3.5.4.7  Comm Tab

The SQS-242 software can be controlled by another computer through an RS-232 
or Ethernet connection. See section 5.2 on page 5-1 for more details.

Figure 3-24  Comm tab

RS-232 Port: Selects the comm port used for serial communications with another 
computer. The Comm Port dropdown box lists available ports. 
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Baud Rate: Sets the baud rate used for serial communications.

Ethernet Ports: Local Port sets the TCP/IP port used by the SQS-242 software for 
Ethernet communications (1001 is a typical value, -1 for no Ethernet). When 
communications is established, Remote Port displays theTCP/IP port of the remote 
computer communicating with the SQS-242 software.

Ethernet Name: Displays the name of the local and remote computers, as set in 
their Windows, My Computer dialog box.

Ethernet IP Address: Displays the IP address (xxx.xxx.xxx.xxx) of the local and 
remote computers.

Receive Data: Displays the Query and Update requests received from the Comm 
and Ethernet port. See section 5.6 on page 5-2 for a description of the serial 
communications protocol.

Transmit Data: Displays the response to Query and Update requests received 
from the Comm and Ethernet port.

NOTE: The Comm tab does not monitor communications with the PLC.

3.5.5  Edit: Security

The Security menu assigns Users, their Password, and their Access Level. It also 
provides a flexible way to assign program functions to different Access Levels.

NOTE: The Security dialog box is available only to users with Supervisor Access.

3.5.5.1  Users Tab

Figure 3-25  Users tab
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User: Dropdown box used to select an existing user, to edit their Access or 
Password. It is not possible to edit or add a user name in the User dropdown. Use 
the New SoftKey to create a new User. Use the Delete SoftKey to delete the 
selected user.

Access: Assigns a program access level to the selected user. Generally speaking, 
Supervisor (SUPV) provides access to all program functions. Technicians (TECH) 
have access to a subset of functions. While User level access (USER) has access 
to only those functions needed to run deposition processes. See the Access Tab 
section to assign SUPV, TECH, and USER program capabilities.

Password: Each user will typically have their own password. When a password is 
entered, a second box will appear for password confirmation. If the Password box 
is left blank, no Password is needed for that user to login.

NOTE: User names and passwords are limited to A-Z, 0-9, _, -, and space. 
Passwords are a maximum of 8 characters.

3.5.5.2  Access Tab

The Access tab allows Supervisors to assign which program functions are 
available to each of the three Access Levels. When a program function is assigned 
to a particular access level, it is automatically available to higher access levels.

In Figure 3-26, every user has access to the File Process menu and the File Exit 
menu. Only Supervisors have access to the Edit System and Edit Security menus. 
The remaining menus are assigned TECH access. They will be available to TECH 
and SUPV users, but not to USER access users.

The settings along the right side of the Main Form can be viewed by any user, but 
values can only be edited by TECH or higher access.

Those who login with USER access can select and run processes, but they cannot 
edit process parameters. TECHs can also select and run processes (because 
those functions are assigned to a lower level access). However, TECHs can also 
edit process parameters. Only Supervisors can change System Setup or Security 
assignments.
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Figure 3-26  Access tab

3.6  View Menu

The View menu controls the appearance of the main display.

Film Settings: Displays/hides a ribbon of commonly accessed process settings 
along the right of the dialog box. Additional process parameters are available in the 
Edit menu. When displayed, the settings ribbon allows the user to easily modify 
process settings during deposition without leaving the main dialog box. Changes 
are made to the current process and the process database immediately. In 
CoDeposition, first click on the desired film to display its parameters. 

Film Readings: Displays/hides film deposition readings along the bottom of the 
dialog box. Readouts of Film, Rate, Deviation, Thickness, and Power are displayed 
simultaneously for each of the active outputs. The rate, deviation, and thickness 
readings displayed represent an average of the quartz sensors assigned to each 
film.

Sensor Readings: Displays/hides a pop-up window of sensor rate, thickness, 
remaining life, and frequency readings. Unlike the main dialog box’s Film 
Readings, this display is the raw data coming from each sensor. In addition, the 
output (i.e., PID control loop) that each sensor is assigned to is displayed. Sensor 
assignments are established on the Sensor tab of System dialog box. 

A (P) in the Control column indicates the sensor is the primary sensor of a dual 
sensor pair. (S) indicates a secondary sensor. An (R) in the Control column 
indicates that the sensor is being used only for rate control. A (T) indicates the 
sensor is used only for Final Thickness endpoint detection. An (M) indicates the 
sensor is being used to monitor, but not control, the output. These options are 
selected on the Sensor tab of System dialog box
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NOTE: The Sensor Readings dialog box can be sized to also show SAM-242 card 
analog input readings and digital I/O information. The digital I/O 
information is useful for troubleshooting I/O problems during setup.

Rate Graph: Fixes the main graph to deposition rate. Deposition rate is useful 
during the shutter delay, rate ramp, and deposition phases. During other phases, 
the power output graph is usually more useful.

Deviation Graph: Fixes the main graph to display percent deviation from the rate 
setpoint. Rate deviation is useful for fine tuning the PID control loop.

Power Graph: Fixes the main graph to output power. Output power is directly 
adjusted during the PreConditioning, feed, and hold phases. Output power is also 
useful during the deposition phases to detect error conditions, which cause 
oscillations. Be sure the Full Scale voltage is set properly in the SQM-242 Setup 
menu.

Sensors Graph: Normally the graph displays output, or film-based information. 
The Sensors Graph selection displays the rate readings from each individual 
sensor assigned to a system setup. It is a graphical display of the Rate column of 
the Sensor Readings dialog box.

Analog Graph: If an SAM-242 analog input card is installed, this graph shows the 
voltage readings from each analog input assigned to a system setup. 

Automatic: Changes the main graph to display the most pertinent information for 
each deposition phase. During preconditioning, output power is displayed. During 
shutter delay, rate ramps, and deposition, the main graph displays deposition rate. 
During feed and hold phases, the graph reverts to output power.

NOTE: To alter the appearance of a graph, right-click anywhere on the graph. Use 
the Graph Property Page dialog box to alter the graph to your preferences. 
To permanently save the changes, click the Control tab, the General tab, 
then the Save button. Save the graph setup to the appropriate .OC2 file for 
the graph you are modifying.

High Resolution: When this option is checked, rate is displayed to 0.01 Å/s, and 
thickness to 0.1kÅ. This can be useful for low rate applications, but annoying for 
moderate rates. The SQM-242 card resolution for PID control is unchanged.

3.7  Software Specifications

Display

Graphs . . . . . . . . . . . . . . . . . . . . . . . Rate, Deviation, Power

Readouts  . . . . . . . . . . . . . . . . . . . . . Rate, Dev, Thick, Power

Process Parameters

Name . . . . . . . . . . . . . . . . . . . . . . . . 12 characters
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# Processes . . . . . . . . . . . . . . . . . . . Unlimited

# Layers . . . . . . . . . . . . . . . . . . . . . . Unlimited

# Films . . . . . . . . . . . . . . . . . . . . . . . Unlimited

# Rate Ramps  . . . . . . . . . . . . . . . . . Unlimited

# Sensors (Dual)  . . . . . . . . . . . . . . . 1 to 8 (4 Dual)

# Sources . . . . . . . . . . . . . . . . . . . . . 1 to 6

Layer Parameters

Film  . . . . . . . . . . . . . . . . . . . . . . . . . Any defined

Output  . . . . . . . . . . . . . . . . . . . . . . . 1 to 6

Input . . . . . . . . . . . . . . . . . . . . . . . . . Sensor(s)
Timed Power
Analog Input

SetPoint . . . . . . . . . . . . . . . . . . . . . . 0.00 to 999.99 Å/s
0.00 to 100.00% Power
0.00 to10.00 V(dc)

Final Thickness  . . . . . . . . . . . . . . . . 0.0 to 999.9 kÅ

Time EndPoint . . . . . . . . . . . . . . . . . 0 to 30000 s

Thickness EndPoint . . . . . . . . . . . . . 0.0 to 999.9 kÅ

Start Mode . . . . . . . . . . . . . . . . . . . . Auto/Manual

Source Indexers . . . . . . . . . . . . . . . . 6, Index 1-16

Layer Indexers . . . . . . . . . . . . . . . . . 3, Index 1-16

Rate Ramp Start. . . . . . . . . . . . . . . . 0.0 to 999.9 kÅ

Rate Ramp Time  . . . . . . . . . . . . . . . 0 to 1000 s

New Rate . . . . . . . . . . . . . . . . . . . . . 0.00 to 999.99 Å/s

Film Parameters

Name . . . . . . . . . . . . . . . . . . . . . . . . 12 characters

Ramp Time (1,2)  . . . . . . . . . . . . . . . 0 to 30000 s

Soak Power (1,2) . . . . . . . . . . . . . . . 0.0 to 100.0%

Soak Time (1,2) . . . . . . . . . . . . . . . . 0 to 30000 s

Shutter Delay Time. . . . . . . . . . . . . . 0 to 200 s

Shutter Delay Error  . . . . . . . . . . . . . 0.0 to 30.0%

P Term . . . . . . . . . . . . . . . . . . . . . . . 1 to 9999
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I Term . . . . . . . . . . . . . . . . . . . . . . . . 0 to 999.9 s

D Term . . . . . . . . . . . . . . . . . . . . . . . 0 to 99.9 s

Control Error . . . . . . . . . . . . . . . . . . . Ignore/Stop/Hold

Control Error Set  . . . . . . . . . . . . . . . 0 to 30.0%

Feed Ramp Time . . . . . . . . . . . . . . . 0 to 30000 s

Feed Power  . . . . . . . . . . . . . . . . . . . 0.0 to 100.0%

Feed Time  . . . . . . . . . . . . . . . . . . . . 0 to 30000 s

Idle Ramp Time  . . . . . . . . . . . . . . . . 0 to 30000 s

Idle Power  . . . . . . . . . . . . . . . . . . . . 0.0 to 100.0%

Tooling (Sensor 1 to 8) . . . . . . . . . . . 10.0 to 999.0

Max Power . . . . . . . . . . . . . . . . . . . . 0.0 to 100.0%

Slew Rate . . . . . . . . . . . . . . . . . . . . . 0.0 to 100.0%/s

Source Index (Pocket)  . . . . . . . . . . . 0 to 15

Material Parameters

Name . . . . . . . . . . . . . . . . . . . . . . . . 12 characters

Density . . . . . . . . . . . . . . . . . . . . . . . .0.40 to 99.99 gm/cm3

Z-Factor . . . . . . . . . . . . . . . . . . . . . . 0.100 to 9.900

Digital Inputs (available only with PLC option)

Start Process

Stop Process

Start Layer

Stop Layer

Start Next Layer

Zero Thickness

Force Final Thickness 

Substrate Index Complete

Source Index Complete

Relay Outputs (available only with PLC option)

Source Shutter . . . . . . . . . . . . . . . . . 1 to 6

Sensor Shutter . . . . . . . . . . . . . . . . . 1 to 8

All Crystal Fail
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All Crystal Good

Process Running

Process Stopped

Process Active

Deposit Phase

Pre-Cond Phase

Feed/Idle Phase

Manual Mode

Max Power

Thickness Setpoint

Time Setpoint

Final Thickness

Substrate Index Select . . . . . . . . . . . 0 to 15

Source Index (Pocket) Select. . . . . . 0 to 15

Security

User Name . . . . . . . . . . . . . . . . . . . . 16 characters

Password . . . . . . . . . . . . . . . . . . . . . 8 characters

Access . . . . . . . . . . . . . . . . . . . . . . . 3 levels

Computer Interface

Type . . . . . . . . . . . . . . . . . . . . . . . . . RS-232, Ethernet, ActiveX
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3.8  INI File Parameters

Parameters that control operation of the SQS-242 program are stored in the 
SQS242.INI file. Most of these are easily altered within the program and updated 
automatically. 

However, a few of the parameters cannot be changed within the program. Use a 
text editor to alter the parameters listed below. 

CAUTION

Always make a backup of the INI file before editing!

MDISize = Left, Top, Width, Height (Screen size and location (in pixels))

Debug = True or False (Show SQM-242 card error messages)

Show = True or False (True loops continuously through a process)

KillErrLog = True or False (True clears error log each time application)

NumberFormat = 0 or 1 (0 uses Windows setting for number format)
(1 uses the U.S. format (i.e., 1,000.00))

BackColor = Color (Default is BLACK)

ForeColor = Color (Default is LIGHTGRAY)

HighLightColor = Color (Default is WHITE)

The next four parameters control setup of the 4 indexer values where:

Name is the Indexer label on the Process form

Start is the first index number, typically 0 or 1

End is the last index number, typically 15 or 16

First is the text displayed for the Start index number

SourceIndex = Name, Start, End, First

LayerIndex1= Name, Start, End, First

LayerIndex2= Name, Start, End, First

LayerIndex3= Name, Start, End, First
  3 - 37



IP
N

 0
7

4-
55

1-
P

1
A

 SQS-242 Operating Manual
This page is intentionally blank.
3 - 38  



IP
N

 0
7

4-
55

1-
P

1
A

SQS-242 Operating Manual
Chapter 4
Digital I/O

4.1  Introduction

Digital I/O for the SQS-242 software can be handled by an inexpensive PLC. This 
section will cover interfacing a Omron CPM2 series PLC to the SQS-242 card and 
PC. It is not necessary, however, to use external I/O with the SQS-242 software.

There are several benefits to using an external PLC for I/O. First, noisy high voltage 
wiring can be placed near the control sources, rather than routed into the 
controller’s equipment rack. Only a single serial cable runs from the PLC to the 
controller. The PLC also provides electrical isolation for the process controller. And 
finally, the PLC’s ladder logic programming provides fail-safe process protection 
and allows I/O to be easily tailored to each end user’s installation.

4.2  PLC Installation

CAUTION

The Omron PLC uses a special RS-232 cable as shown in 
Figure 4-1. Do not use a standard serial cable. Damage to 
the PC or the PLC could result.

Figure 4-1  Omron PLC RS-232 Cable
  4 - 1



IP
N

 0
7

4-
55

1-
P

1
A

 SQS-242 Operating Manual
Mount the PLC controller near the devices it is controlling and sensing. Connect 
the PLC to a properly grounded power source. See the PLC User Manual for 
detailed PLC mounting and connection information. Connect the serial cable 
supplied from the PLC serial port to your computer serial port.

Input Wiring: The 0.0 to 0.11 inputs on Omron PLCs correspond to Inputs 1 to 12 
in the SQS-242 software. Omron PLC input wiring is shown in Figure 4-2.

Figure 4-2  Omron PLC Input Wiring

Output Wiring: The PLC output relays are mapped to output events using the 
SQS-242 software’s Edit, System dialog, I/O Events tab. 

NOTE: Relays 1 to 8 in the SQS-242 software correspond to relays 10.00 to 10.07 
on the PLC. Relays 9 to 12 correspond to Omron relays 11.00 to 11.03.
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Figure 4-3  Omron PLC Output Wiring

Omron PLC output wiring is illustrated in Figure 4-3. Notice that some relays (i.e., 
02/03 and 04/05/06/07) share a common terminal.

NOTE: The internal 24 V (dc), .3 A supply of the Omron PLC is NOT adequate to 
serve as the supply shown in the diagram above. 

Indexer I/O: Indexers from different manufacturers use a variety of pocket 
decoding schemes. The PLC monitor program adapts information from the 
SQS-242 program to a specific indexer. The two most common indexer decoding 
schemes are illustrated below. 

Binary Pocket Select: Each pocket requires a dedicated relay. That is 8 pockets 
require 8 relays. The CPM2A-Basic PLC monitor program assigns relays 11.00 to 
11.03 to operate a 4 pocket indexer of this type.

Binary Coded Pocket Select: Pockets are selected by a value that is the binary 
representation of the pocket. That way fewer relays are required. For example, 16 
pockets can be selected with only four relays. The CPM2A-BCD monitor program 
assigns relays 11.00 to 11.03 to this function.

Please contact INFICON for information on your indexer.

Other Digital I/O: Depending on the PLC model used, additional relay and input 
pins are available for other functions (i.e., source indexer operation). Please 
contact INFICON.
  4 - 3
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4.3  PLC Setup and Test

In the SQS-242 software select Edit, System, then the I/O tab. Set the Address to 
match the PLC Address (usually 0). Set the Comm Port to the serial port you are 
using. The COMM LED on the PLC should flash several times a second when the 
Address and Comm Port are set properly.

The Test section of the I/O tab provides a means of testing your PLC 
communications and digital I/O wiring. To set a relay on the PLC, go to the Digital 
I/O tab and find which I/O event is assigned to that relay. On the PLC tab, select 
the same event in the test dropdown, then click Set. The assigned Relay# should 
close. Click Clear to open the relay.

The Indexers tab of the Edit System dialog box allows you to move a source or 
substrate indexer. Select the index (i.e., pocket) to activate, then click the 
appropriate move button.

4.4  5.3 PLC Programming

The PLC runs a small ladder logic program that communicates with the SQS-242 
software. This program transfers external relay and input states from the PLC 
connecting block to internal PLC registers. The SQS-242 software reads/writes to 
those registers. 

The preset functions of the SQS-242 software will be adequate for most 
applications. If you need to perform additional logic functions, they can be 
programmed using Omron’s CX-Programmer software. Contact INFICON for more 
information on programming your PLC.

The functions of the internal PLC registers used by the standard SQS-242 program 
are shown below.

PLC Register SQS-242 Function

200 Layer/Phase Register
Bits 0-9 are BCD layer number running
Bits 10-15 are BCD Phase# as shown below
   00      Application Startup 09 ShutterDelay Phase
   01      Program Initializing 10 Deposit Phase
   02      Not Used 11 Layer Stopped
   03      Not Used 12 Layer Starting
   04      Process Stopped 13 Not Used
   05      Ramp1 Phase 14 Feed Ramp Phase
   06      Soak1 Phase 15 Feed Hold Phase
   07      Ramp2 Phase 16 Idle Ramp Phase
   08      Soak2 Phase 17 Idle Phase

18 Continuous Phase

201 Sensors/Outputs 1-4 Register (updated each layer)
Bits 0-7 are sensors used (1=used, 0=unused)
Bits 12-15 are outputs used, 12 is Out1, 13 is Out2, etc.
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202 Analog/Outputs 5-6 Register (updated each layer)
Bits 0-3 are analog inputs used (1=used, 0=unused)
Bits 4-5 outputs used, 4 is Out5, 5 is Out6
Bits 8-11 are BCD of Output source index
Bits 12-15 are BCD of Output 6 source index

220 Source Index Register (updated each layer)
Bits 0-3 are BCD of Output 1 source index
Bits 4-7 are BCD of Output 2 source index
Bits 8-11 are BCD of Output 3 source index
Bits 12-15 are BCD of Output 4 source index

221 Source Indexer Done Flag
Bit 0 is Source Indexer 1 (1= Indexer Done, 0=Not Done)
Bit 1 is Source Indexer 2
Bit 2 is Source Indexer 3
Bit 3 is Source Indexer 4
Bit 4 is Source Indexer 5
Bit 6 is Source Indexer 6

222 Relays 1-16
Bit 0 is Relay 1, etc.

224 Inputs 1-12
Bit 0 is Input 1, etc.

225 Layer Index Register
Bits 0-3 are BCD of Layer Indexer 1
Bits 4-7 are BCD of Layer Indexer 2
Bits 8-15 are BCD of Layer Indexer 3

226 Layer Indexer Done Flag
Bit 0 is Layer Indexer 1 (1= Indexer Done, 0=Not Done)
Bit 1 is Layer Indexer 2
Bit 2 is Layer Indexer 3
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Chapter 5
Communications

5.1  Introduction

The computer interface capabilities of the SQS-242 program allow operation from 
an external computer via Ethernet or RS-232 serial communications and a simple 
ASCII command set. Programs running on the same computer, can also control the 
SQS-242 program using ActiveX® and the same ASCII command set.

Parameters may be read (Query commands) while the process is running, but can 
only be changed (Update commands) while the process is stopped. Changes to the 
“structure” of a process (e.g., add or delete layers) are not allowed from the 
computer interface. 

5.2  Serial Interface

Connect a serial cable from the serial port of the computer the SQM card is 
installed on to another computer’s serial port. The cable required is a DB9 female 
to female with pins 2 and 3 crossed, commonly referred to as a null modem cable.

In the SQS-242 program select the Edit, System menu, then the Comm tab. Set 
the Comm Port to match the serial port the cable is connected to on the other 
computer. Set the baud rate to match between the host computer and the remote 
computer. Communications format is No Parity, 8 bits, 1 stop bit.

5.3  Ethernet Interface

Connect a cable from the Ethernet card to your Ethernet network. In the SQS-242 
program select the Edit, System menu, then the Comm tab. Set the Ethernet Port 
to 1001, and the Ethernet name to the Network name, or IP Address of the 
computer you wish to communicate with. Enter a –1 for the Ethernet Port to disable 
the Ethernet functions.

5.4  ActiveX (COM) Interface

Any program that supports Microsoft’s COM (ActiveX) interface (i.e., LabVIEW®, 
etc.) can communicate with the SQS-242 program. A small ActiveX interface 
program, SQS242X.EXE, provides receive data and transmit data entry points to 
the global cComm242 class. Contact INFICON for examples in other languages, 
and detailed technical information.
  5 - 1
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5.5  SQS-242 Comm Program

SQS-242 Comm, found on the SQS-242 CD-ROM, is a simple Windows program 
to demonstrate SQS-242 communications concepts. With SQS-242 Comm you 
can easily send commands to, and read the responses returned by the SQS-242 
program. 

5.5.1  Setup for RS-232 or Ethernet

In the SQS-242 program, select Edit, System and set the RS-232 or Ethernet 
settings as detailed in the previous sections.

Load the Comm program on a computer (the host), and connect an Ethernet or 
RS-232 cable between the host and the computer running the SQS-242 program. 
Start the Comm program on the host computer, then select the Utility tab. Set the 
Comm Port and Baud Rate for the host computer, or select Ethernet and set the 
Ethernet Port (typically 1001).

5.5.2  Setup for Active X Control

Load the Comm program on the same computer that is running the SQS-242 
program. Start the Comm program, then select Active X on the Utility tab. Start the 
SQS-242 program but minimize it, or bring the Comm program to the foreground.

5.5.3  Communicating with the SQS-242 Program

In the Comm program, Utility tab, click the Version button under the SID-242 
Controller heading. Click Send to send the query to the computer running the 
SQS-242 program. 

The response from the SQS-242 program should show in the Comm program 
Response window. A typical response is @QU;ACK;3.2.9;32, which indicates 
software version 3.29. The next section describes the Query/Update and 
Response strings in detail.

The transmissions to and from the Comm program will also show in the SQS-242 
Edit, System, Comm, Receive Data and Transmit Data windows.

5.6  Protocol

SQS-242 commands fall into two categories:

 Query commands request data from the SQS-242 program. 

 Update commands update a setting or instruct the program to take an action. 

The SQS-242 responds to both Query and Update commands with a response that 
indicates the results of the command request. The SQS-242 program never 
initiates communications. It only responds to commands from the host. 
5 - 2  
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5.6.1  Query Command Format
@<command>;<param1>;…;<paramn>;<Chksum><CR>

5.6.1.1  Example: Software Version Query
@QU;11;44<CR> 
where:
@ Message start character
; Separator
QU Query Utility command
; Separator
11 Parameter 11 (SQS-242 Software Version)
; Separator
44 Checksum (see section that follows on checksums)
<CR> Carriage Return (ASCII 13)

5.6.1.2  Example: Response to Software Version Query
@QU;<ACQ>;2.1.6;??<CR> (Response to Software Version query)
where:
@;QU;<ACQ>; Query Acknowledged (ASCII 06)
2.1.6 Message (Software Version)
; Separator
0C Checksum (actual checksum varies with different 

versions)
<CR> Carriage Return (ASCII 13)

5.6.2  Update Command Format
@<command>;<param1>;...;<paramn>;<data>;<Chksum><CR>

5.6.2.1  Example: Set Process Update
@UP;11;MyProcess;44<CR>
where:
@;UP; Update Process command
; Separator
01 Parameter 01 (Set Process)
; Separator
MyProcess Data
; Separator
?? Checksum
<CR> Carriage Return (ASCII 13)

5.6.2.2  Example Response: Set Process Update Succeeded
@UP;<ACQ>;??<CR>
  5 - 3
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5.6.2.3  Example Response: Set Process Update Failed
@UP;<NAK>;<ERR>;??<CR>
Where:
01 Illegal Command
02 Illegal Parameter
03 Illegal Format
04 Checksum Error
05 Request Denied
06 Unknown Error

5.7  Checksum Calculation

The sample code below calculates the FCS checksum of a string of characters.

In the code, Message is a string that has been stripped of terminator and checksum 
characters before being passed to this routine.

' XOR ASCII codes
For i = 1 To Len(Message)
    FCS = Asc(Mid$(Message, i, 1)) Xor FCS
Next i

' Convert FCS to two character hex string
If Len(Hex$(FCS)) = 1 Then
    CalcChkSum = "0" & Hex$(FCS)
Else
    CalcChkSum = Hex$(FCS)

NOTE: While checksums “may” be useful for RS-232 communications, they are 
not needed for Ethernet or ActiveX. If you don’t want to use a checksum, 
replace the checksum in each command with “00” (two ASCII zero (Hex 
30) characters). The program response will contain two checksum 
characters, which you can just ignore.
5 - 4  
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5.8  Command Summary

NOTE: Update commands (except UP02-UP10) are only valid in Stop Mode.

5.8.1  Query Process
@QP;<param1>
where <param1> is:
01 Process Name

Example Query: @QP;01
Example Response: @QP;06;MyProc(Process is MyProc)

02 Process Time (mm:ss)
03 Active Layer #
04 Layer Time (mm:ss)
05 Phase # (where phase numbers returned are)

00      Application Startup 09 ShutterDelay Phase
01      Program Initialize 10 Deposit Phase
02      Not Used 11 Layer Stopped
03      Not Used 12 Layer Starting
04      Process Stopped 13 Not Used
05      Ramp1 Phase 14 Feed Ramp Phase
06      Soak1 Phase 15 Feed Hold Phase
07      Ramp2 Phase 16 Idle Ramp Phase
08      Soak2 Phase 17 Idle Phase

06 Phase Time (mm:ss)
07 Run #
08 All Process Names (comma delimited list)
1n Source Shutter Status, n=1 to 6 (0=Open, 1=Close)
2n Sensor Shutter Status , n=1 to 8 (0=Open, 1=Close)
30 All Crystal Good Status (0=False, 1=True)
3n Crystal n Good, n=1 to 8 (0=False, 1=True)
39 All Crystal Fail (0=False, 1=True)
4n Sensor to Output Map, n=1 to 8
50 DataLog Filename
51 DataLog Type (0=None, 1=Overwrite, 2=Append, 3=Run#)
52 DataLog Interval in seconds

5.8.2  Update Process
@UP;<param1>;<data>
where <param1> is:
01 Set Process

Example Update @UP;01;MyProc(Select MyProc)
Example Response: @UP;06;

02 Start Process
03 Stop Process
04 Start Layer
05 Stop Layer
06 Start Next Layer
07 Auto Mode (all films in layer)
08 Manual Mode (all films in layer)
09 Zero Thickness (all films in layer)
10 Set Run #
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11 Set Active Layer #
2n Output n (1 to 6) Power (Manual Mode Only)
4n Map Sensor n to Output #
50 Set DataLog filename without extension (Stop mode only)
51 DataLog type (0=None, 1=Overwrite, 2=Append, 3=Run#)
52 DataLog Interval in seconds (set Bit 3 in Command 53 below)
53 DataLog Events (bit weighted integer)

Bit 0 End Deposit Phase
Bit 1 End Each Phase
Bit 2 I/O Event
Bit 3 Timed
Bit 8 Every Reading
Bit 9 Sensor Readings
Bit 10Analog Readings

5.8.3  Query/Update Layer
@QL;<param1>;<layer>;<output>
@UL<param1>;<layer>;<output>

NOTE: A <layer> value of zero sets/returns data on the current layer.
where <param1> is:
01 Film Name

Example: @UL;01;1MyFilm,New Film (set Layer 1, MyFilm to 
NewFilm)

02 Setpoint Å/s, V, or % Power
03 Start Thickness kÅ
04 Time SP mm:ss
05 Thickness SP kÅ
06 Start Mode 0/1
07 Substrate Index (obsolete) 0 to 15
08 # Layers in Process (query)
09 Start Prompt 250 characters or less
10 Phase of the requested output (query)
1n Ramp n Start Thickness, n=1 to 9 kÅ
2n Ramp n Ramp Time, n=1 to 9 mm:ss
3n Ramp n New Rate, n=1 to 9 Å/s
41 Layer Indexer 1 Index 0 to 15
42 Layer Indexer 2 Index 0 to 15
43 Layer Indexer 3 Index 0 to 15
44 Source Indexer Index 0 to 15
45 Input Type (Sensors=0, TimedPower=1, Analog1-4 = 2-5)
46 System Configuration
47 Source Indexer Done 0/1
48 Layer Indexer 1 Done 0/1
49 Layer Indexer 2 Done 0/1
50 Layer Indexer 3 Done 0/1
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5.8.4  Query/Update Film
@QF;<param1>;<layer>;<output>
@UF;<param1>;<layer>;<output>;<value>
Note: <layer>=0 is active layer
where <param1> is:
01 P Term
02 I Term
03 D Term
04 Shutter Delay Status (0/1)
05 Shutter Timeout
06 Shutter Accuracy
07 Control Error Status (0/1/2)
08 Control Error Accuracy
09 Rate Sampling Status (0/1/2)
10 Sample Accuracy
11 Sample Time
12 Sample Hold 
13 Ramp 1 Power
14 Ramp 1 Time
15 Soak 1 Time
16 Ramp 2 Power
17 Ramp 2 Time
18 Soak 2 Time
19 Feed Power
20 Feed Ramp Time
21 Feed Time
22 Idle Power
23 Idle Ramp Time
24 Output (1-6)
25 Source Index (obsolete)
26 Max Power
27 Slew Rate
28 Material
3n Tooling n (n=1 to 8)
40 AutoSoak2 (0/1)

5.8.5  Query Utility
@QU;<param1>
01 SQM242 DLL Version
02 SQM242 Mode (0/1)
03 SQM242 Period
04 SQM242 Filter
05 SQM242 Number of Cards Installed
06 Front Panel Enabled (0/1)
07 Application Visible (0/1)
11 SQS-242 Software Version
12 SQS-242 Operating System
13 SQS-242 Computer Name
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5.8.6  Update Utility
@QU;<param1>;<Index>
02 SQM242 Mode (0/1)
03 SQM242 Period
04 SQM242 Filter
06 Front Panel Enabled (0/1)
07 Application Visible (0/1)
08 Full Scale Output (Index=1 to 6)
14 Application On Top(0/1)

5.8.7  Query Measurement
@QM;<param1>
1n Output n Power (n=1 to 6)
2n Output n Rate
3n Output n Thickness
4n Output n Deviation
5n Sensor n Rate (n=1 to 8)
6n Sensor n Thickness
7n Sensor n Frequency
8n Sensor n % Life
9n Analog Input n Voltage

5.8.8  Query Register
@QR;<param1> (returns register value in HEX)
0 Layer/Phase Register
1 Sensor/Output Register
2 Analog/Output Register
20 Source Index Register
21 Source Index Done Register
22 Relay Register
24 Input Register
25 Layer Index Register
26 Layer Index Done Register

5.8.9  Update Register
@UR;<param1>;<value> (value in HEX)
0 Layer/Phase Register
1 Sensor/Output Register
2 Analog/Output Register
20 Source Index Register
21 Source Index Done Register
22 Relay Register
24 Input Register
25 Layer Index Register
26 Layer Index Done Register
XXX Any Register
5 - 8  



IP
N

 0
7

4-
55

1-
P

1
A

SQS-242 Operating Manual
Chapter 6
Loop Tuning

This section will help you adjust your control loop PID parameters to achieve a 
stable deposition process. Keep in mind that there is no "best" way to determine 
PID parameters, and no one set of settings that are "best."

1 Setup System Parameters: Be sure that the output Full Scale voltage and 
crystal Min/Max Frequency parameters are accurate for your system. All 
Tooling parameters are best set to 100% for now. A Period of .25 seconds is 
also a good starting point. Simulate should be OFF.

2 Create a One-Layer Test Process: Create a new process that has a single 
film as its only layer, and select it as the current process. Set the film's Initial 
Rate to your desired rate and Final Thickness to a large value, say 10X your 
desired Final Thickness. Select the proper Sensor(s), Output, and Material. Set 
Max Power to 100% and Slew rate to 100%. Disable all errors except Crystal 
Fail. Set On Error to Stop Layer.

3 Test the Setup: Press Auto/Manual to start the layer in Manual mode. Slowly 
turn the control knob to a power of 10%, and verify that your power supply 
output is about 10% of full scale. Continue to turn the control knob until a 
Rate(Å/s) above 0 is shown. Again, verify that the power supply output agrees 
with the SQS-242 Power(%) reading. If the readings don't agree, check your 
wiring and process setup. In particular, verify that the System, Outputs, Full 
Scale voltage agrees with your power supply input specifications.

4 Determine Open Loop Gain: Slowly adjust the control knob until the Rate(Å/s) 
reading approximately matches your Initial Rate setting. Record the Power(%) 
reading as PWRDR (power @ desired rate). Slowly lower the power until the 
Rate(Å/s) reading is just at (or near) zero. Record the zero rate Power(%) 
reading as PWR0R.

5 Determine Open Loop Response Time: Calculate 1/3 of your desired rate 
(RATE1/3), and 2/3 of the desired rate (RATE2/3) for this layer. Slowly increase 
the power until Rate(A/s) matches RATE1/3. Get ready to record the loop's 
response to an input change. Quickly adjust Power(%) to PWRDR. Measure 
the time for the Rate (A/s) reading to reach RATE2/3. You may want to do this 
several times to get an average response time reading. Displaying the Rate 
graph will also help. Twice the measured time is the step response time, 
TIMESR. TIMESR is typically 0.7 to 1.5 seconds for E-Beam evaporation, 5 to 
20 seconds for thermal evaporation.

Press Abort Process, then Manual/Auto to return to Auto mode. Follow these steps 
to set the loop PID parameters:
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6 Set PID Values: In the Edit Process, Deposition tab set P=25, I= TIMESR, D=0. 
Assure that all Conditioning values are set to zero. Save the values and close 
the Edit Process dialog. Press Start Process and observe the Power graph. The 
power should rise from 0%, and stabilize near PWRDR with little ringing or 
overshoot. If there is more than about 10% overshoot, lower the P Term. If the 
time to reach PWRDR is very slow, increase the P Term. A lower I Term will 
increase response time, a higher value will eliminate ringing and setpoint 
deviations. It is unlikely you will need any D Term.

Continue to Start the process and adjust PID until steady-state response is 
smooth and the step response is reasonably controlled. You don't need to 
totally eliminate ringing during the step if the steady-state response is smooth. 
Preconditioning will minimize step changes.

7 Set Preconditioning: The power level you recorded as PWR0R is the power 
where deposition just begins. That's a good value for Ramp 1 power. PWRDR, 
or slightly less, is a good value for Ramp 2 Power. This will eliminate a large 
step change when entering the deposition phase.

Once PID terms are established for a material, they will typically be similar for other 
materials. Only the P Term and preconditioning power levels may need adjustment.
6 - 2  
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